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User Registration Tips 

1. When creating a new user the Last Name and email address must be the same in WBSCM and eAuthentication 
2. When adding a new user in WBSCM, the Save button should be selected after the roles have been added to the new 

user. If the save button is selected prior to selecting the roles, the user admin can select that new user from the top and 
select modify to add the roles to the new user.  

3. A user admin can re-send a new users the WBSCM registration email by selecting the user in the manage users tab, 
going to the last tab (data tab) and selecting the re-send registration email 

4. Most common issues with registration: 
a. New user selects the wrong link in the WBSCM registration email 
b. New user does not select the “accept” within the notification from eAuthentication. This must be done within 7 

days of the creation of the eAuthentication account.  
c. User enters a different last name/email address in eAuthentication than what is in WBSCM. 
d. After creating and activating the new account, the user fails to return to the Registration email that they received 

from WBSCM_User_Registration and click the link in step two in order to complete the registration process. 

5. Registration emails that are sent to users when their WBSCM profile is created are for that specific user only and 
SHOULD NOT BE SHARED.  If a user tries to register using another person’s registration email it will not work.  

 
FAQS  

WBSCM LOGON-- 

1. Quick Reference for WBSCM Registration 

1. Look for the WBSCM Registration email.  This email is automatically sent when your User Admin creates an account in 
WBSCM. The Subject line will read Action Required: Register USDA WBSCM User Account 

2. Proceed to step 1 in the email.  This is a two step process.  

 A. Create an E-auth account- Follow the link in this step. You will receive an email after you create this account 

 B. Activate the E-Auth Account 

To activate the account you will receive an email. Subject Line will read Action Required: Instructions to Activate your 
USDA account with Level 1 Access. 

Click on the link in step 3.  This will activate the account. 
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3. After you have activated the E-Auth account, you now need to officially register the account.  To do this, return to the 
email with the subject line Action Required: Register USDA WBSCM User Account. 

A. Click on the link in step 2 

B. Log in using your new login ID and password 

C. Accept the Rules of Behavior 

D. Read the reminder in step 3 of the email 

 
2. What do I do if I forgot my password?  

1. Go to eAuth webpage (https://identitymanager.eems.usda.gov/iam/im/eems) 
2. Select link "I Forgot my Password”. 
3. Click Continue 
4. Follow instructions to reset password 
 
As of July 22, the eAuthentician application which is used to access all USDA applications does not operate correctly with 
Internet Explorer 7 when registering new users or updating existing users.  
Optimal performance for eAuthentician is Internet Explorer 8. 
 
Note:  eAuthentication Password Policies 

• Passwords must have a minimum of 12 and maximum of 24 characters 
• Passwords must include at least one each of the following: uppercase, lowercase, a number, and one of these 

special characters:     ! # $ % = + : ; , ? ~ * -  
• Spaces or dictionary words not allowed 
• Passwords must be changed every 60 days 
• Your previous 24 passwords may not be re-used 
• Inactive accounts are disabled after 400 days  
• After 3 failed login attempts, the account is locked for 60 minutes and this lock cannot be overridden 

 
 

3. WBSCM Email Change and Password Recovery 
If you change your email address, remember to update both your E-Auth and WBSCM profiles.  If you try to reset your 
password and do not have access to your old email account, you will be required to create a new E-Auth ID and WBSCM 
account. 
 

4. I am having problems with the log-in screens rendering correctly. 
Currently, for WBSCM, Internet Explorer 7 or Internet 8/9 in compatibility mode must be used for optimal performance. To 
set the Internet Explorer browser to view WBSCM in the Compatibility View do the following: 
 
1. Go the Tools tab at the top of the browser. 
2. Click Compatibility View Settings 
3. In the Add this website text box type usda.gov and click Add. 
4. Click Close. 
 
Click this link for step by step instructions.  
http://www.fns.usda.gov/fdd/WBSCM/WBSCMfiles/IE7_CompatabilityModeInstructions.pdf 
 

USER ADMIN/ ORG ADMIN/ ROLES-- 

5. How does a user get access allowing them to create requisitions? 
 A User Administrator for the user's organization (e.g. FNS, SDA/ITO, RA) must assign the Order Manager role as 
needed. 
 
 

6. Can an SDA User Administrator grant their RA users access to create orders? 
A SDA User Admin cannot create an RA Order Manager. If there is not a RA User Admin for the particular RA 
Organization, then the SDA User Admin can create a RA User Admin for that particular RA Organization. The User Admin 
for the RA organization can then add the RA Order Manager Role to themselves or any other user in their organization. 

https://identitymanager.eems.usda.gov/iam/im/eems/ca12/index.jsp?task.tag=ChangeMyeAuthenticationPassword
https://identitymanager.eems.usda.gov/iam/im/eems/ca12/index.jsp?task.tag=ChangeMyeAuthenticationPassword
https://identitymanager.eems.usda.gov/iam/im/eems/ca12/index.jsp?task.tag=ChangeMyeAuthenticationPassword
http://www.fns.usda.gov/fdd/WBSCM/WBSCMfiles/IE7_CompatabilityModeInstructions.pdf
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7. What do I need to do to add a new “Ship-to” for my SDA organization?   
In order to add a new Ship-to to WBSCM, you need to complete and send in the FNS-7 to WBSCM-Ship-
To@fns.usda.gov 
  
 

8. Can I view all the Ship-Tos that are assigned to my organization? 
Yes.  SDAs, RAs and Co-Ops can run the Domestic Ship-To Contacts Report to see all Ship-Tos that are assigned to 
their organization. 
 

9. Is there a faster way to assign Ship-To’s to my RA’s? 
Yes.  You can use the Mass Assign Ship-To option to assign a Ship-To to multiple RA’s at a time. 
 
 

10. I have a user who cannot see reports. What do I do?    
Usually the user has not received the “View Only” role. This role is used for viewing reports and all users need to have this 
role. You may also have a user who only reviews reports and having just this role allows them to do this without access to 
create new transactions.  
 
 

11. I have a Supplier WBSCM Account from USDA.  I am also a receiving organization that will be receipting and 
viewing order reports in WBSCM, do I need two logins?   
Yes, you need to have 2 separate eAuths and WBSCM accounts.  You must register for WBSCM twice. 
 
 

12. How can an RA assign a default "Deliver to" (i.e. A Ship-To) location? 
There is no way to assign a default "Deliver to" for an RA. An RA can remove all non-relevant deliver-to's from the RA's 
thereby reducing the number of ship-to's they have to look through. Maintain Ship-To's by being an Org Admin and go to: 
Admin > Organization Maintenance > Update RA Org > Relationships > Has Ship-To (from drop-down), and remove any 
Ship-To locations that are not needed. 
 
 

13. When creating a new RA user what do I put in the FIPS and RA Identifier ID Number fields?   
These fields are a carryover from ECOS and are both optional. 
 
 

14. When the SDA uploads RA updates what happens to the existing data?   
WBSCM will only update the changes while maintaining the rest of the existing data. 
 
 
  

ORDERING/ CART 
 

15. If the SDA/RA clicks “Draft”, do they click “order” or what do they need to do to save it in a “Draft”?  
They must click “Order”. They can then pull the draft up by using “My Transactions” when they need to. 
  

 
16. Will the SDA/RA be able to modify their requisition or order?  

Once they approve the requisition or order, they cannot make changes. If the SDA returns the order to the RA, then they 
can make some limited changes. 
 
 

17. Why can’t my RA see the changes I’ve made to an order/requisition returned by FNS? 
 
After making changes to the order, be sure to Click (the Update Order/Req button) to update the order with the changes 
you made. This is an important step. In most cases, you will want the changes you make to flow back to the original 
requisition. This way, if your RAs or Co-ops (who submitted the requisitions) navigate to the domestic order entry screen 
and display their requisition, they will be able to see changes you made to it as well as any comments explaining those 
changes.  
 
Remember to Click (the Submit Order for Approval button) to submit your changes. (Note) If you do not submit your 
changes, they will not be made. 
 

18. If multiple people at an RA are logged in at the same time, does that affect ordering? For example, if one person 
was ordering meats while another person were ordering vegetables, would that affect anything in WBSCM?  
More than one user can place orders at the same time, but once the order using the last of the entitlement has been 
placed, no more orders may be submitted by either user. Users within the same organization should not try and place 
orders for the same commodities at the same time. 

mailto:WBSCM-Ship-To@fns.usda.gov
mailto:WBSCM-Ship-To@fns.usda.gov


4 
Revised 4/25/2014 

 

 
 

19. How does a user know that their order has been processed and received by the Warehouse? 
You will not receive an email when you create your order. You will receive an email from the system when the warehouse 
ships your order. So, you should expect an email (or several emails) a few days before the items arrive. 
 

20. How does a user change a Direct Delivery Order? 
 
SDA 
Changes can be made to the requisition in the consolidated workbench or the requisition can be returned to the RA to 
allow them to make the changes. 

RA 
After receiving the returned requisition from the SDA, 
Go to: Operations-->Order Processing-->Order Management-->Domestic Order Entry 
My Transactions --> find your order using the search criteria 
 

1. Click the order number when it comes up  

2. When the order is displayed in the cart, click "Change"   

3. Choose the new delivery location and change quantities. (Note that only the SDA can change delivery dates) 

4. Change status to “Ready for Approval” 

5. Click "Update"  

6. Click "Save"  

 
21. How does a user change a multi-food order out of a National Warehouse?   

 
To change an order, go to: Operations-->Order Processing-->Order Management-->Domestic Order Entry 
My Transactions --> find your order using the search criteria 
 
1. Click the order number when it comes up  
2. When the order is displayed in the cart, click "Change"   
3. Choose the new delivery date, change quantities, delete or add commodities for your order. (Note that the date must be 

more than 7 business days in the future) 
4. Click "Update"  
5. Click "Save"  
 
Your order should be updated. 
 
 

22. How do I print my order information? 
After login into the WBSCM system:  
Operations --> Order processing --> Order Management --> Domestic Order entry.  
Please search for your order # under MY transactions Tab, open the order, click on the 'print' button on the screen, you 
will be able to print the sales order.  
 
Suggestion:  
You will be able to print the order from "check out" list, immediately after the order is created.  
 

 
23. How can I find out if my order has been delivered/shipped by the warehouse? 

1. Go back into your order, and look for a 'Follow-on Document' Delivery number at the Line item. If the delivery number 
exists, then you should be able to enter shipment receipt.  You may also check the status of the order.  If the status is 
“purchased” then the order can be receipted.  If the status is “order received” then someone has receipted the order. 
  
2. Go to: Reports > Order Processing > Multi-Food Requisition Report  
--> Enter the Order number in the Order filed > In the report look to see if the 'Delivery #' column has a number in it. If not, 
then the warehouse has not uploaded the Bill of Lading and thus has not created a delivery against this order. 
 
 

24. How can I easily receipt multiple line items on an order? 
1. Enter relevant information at the header level  
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2. Click Receipt All, thereby copying the information to each line and making each line's good quantity the total ordered 
quantity   

3. Go to the line(s) for which you did not receive the total ordered quantity and enter the actual Good quantity received 
plus any damage if applicable. 

4. Click Submit  
 
It is possible to use both the receipt all functionality and changing individual lines. However, to do so, Receipt All must 
be selected before the individual lines are adjusted, otherwise, the Receipt All functionality will over write your values. 
 

25. How to receipt when there is an open quantity? 
 
Sometimes while receipting, you may only have a partial load to receipt.  This causes you to have a receipt with an open 
quantity.  This  means that you can go back into the receipt to update information if necessary until the load has been fully 
receipted.  Anything that was entered into the goods receipt the first time will not be replaced.   

1. Note how much has already been receipted and what is left to receipt so that you do not produce a goods receipt with 
double quantities.  In the screen shot below, you can see that the previous quantity receipted shows in the Prv. Qty. field 
and the amount left to receipt shows in the Open Qty field.   

2.You can only receipt what is noted in the open Qty field.    

Note: Remember not to re-enter data that has already been receipted.  

 

 
 

26. How to receipt replacement orders that were rejected? 
 
1. Proceed to receipt the order as normal 

a. If you originally Rejected 100% of the Line item then you will no longer need to re-enter it again under Rejected Qty 
field. Go ahead and enter Qty under either Good Qty or Good Qty (in CS) or both (depending on whether it is Variable or 
non-variable) and complete your Goods Receipt.   

b. If you partially Rejected a Line Item and partially Receipted the rest then you will see your partially receipted qty 
amount under Prev. Qty (previously receipted) field. Please match the Qty under Open Qty field (Qty remained for you to 
receipt) and complete your Goods Receipts by entering that under either Good Qty or Good Qty (in CS) or both 
(depending on whether it is Variable or non-variable).  

2. You may want to add comments to notate any special notes concerning the replacement order. 

3. Submit receipt as normal 
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27. How can I get Multi-Food Pending Replenishment information?     
Multi-food pending replenishment information can be found by clicking on the hyperlink quantity in the Pending 
Replenishment column of the multi-food catalog. If inventory levels are 0 and there is no pending replenishment quantity 
listed, please contact your regional office and have them find out the products status from the appropriate warehouse 
manager.   

28. How can I see more than just 5 products on a page? 
You can scroll down to the bottom of the screen and choose: Products per page: "All"  
Doing so will show you all the items in the Multi-food catalog.  
 
Choosing the "Select All" button will place a check in the checkbox for all items currently displayed on your screen. Then 
clicking the "Move to Cart" button will move all selected items to your cart. However, just clicking "Select All" will not 
automatically move the items to your cart, you must also click move to cart.  
 
  

29. I am trying to check my orders by running the order status report but when I put in the ship-to or sold-to I get the 
below message:  "Your Query returned no results! Please check your input and try again."  
I have plenty of orders in and ship-to showing is my largest agency so there should be tons of deliveries going 
there. Am I doing something wrong?  
On the Order Status Report, the SDA Organization is always the Sold-To. The Ship-To will be the organization that will 
physically receipt the order (like a warehouse). 
Please make sure that you have entered the correct Ship-to number in the input field. Then rerun the report. 

 

30. How do I use the filter feature in the CWB? 
Use the filter feature on the right hand side to place a blank line at the top of the consolidation table. Enter information into 
the blank line within the column you wish to use as your filter. For this example use the FTL qty in the Quantity column. 
Press Enter. you will now only see those reqs that are a FTL. To remove the filter, click the Delete Filter link. 
 

 
 

31. My RA can’t see the changes I made to a returned FNS order. 
After making changes to a returned order in the Returned FNS Orders screen, be sure to click the Update Order/Req 
button to update the order with the changes you made.  This will also flow changes back down to the original requisition. 



7 
Revised 4/25/2014 

 

When your RAs or Co-ops navigate to the Domestic Order Entry screen and display their requisition, they will be able to 
see changes you made to it as well as any comments explaining those changes. 
 
Remember to click the Submit Order for Approval button to submit your updated orders back to FNS. 
 

32. How can I make sure that I have the most current delivery date information when I’m putting in orders? 
To ensure that you are pulling up the most up-to-date delivery date information for your delivery location, follow these 
steps in this order. 

1. Select the delivery location 

2. Click the Update button (Very Important) 

3. Select a program 

4. Select a product and place it in the cart.  

5. Select a delivery date 

6. Submit your order 

Note:  WBSCM defaults to the next soonest delivery date. If you want to select a date that is further out (while within 30 
business days) you can select if from the drop down before saving your order. 
 

33. If the SDA/RA adds materials to their cart and then logs off of the system, will it save the items in the cart?  
No 
 
 

 
CATALOG/ REQUISITIONS/ ENTITLEMENT—   
 

34. I am unable to view my catalog or commodities in the catalog?  What do I do? 
 

A. If you are the SDA 
Confirm that FNS has created a catalog for your SDA organization and has assigned the correct programs.   
 

B. If you are the SDA & creating Catalog view (Cview) for your RAs 
o Process the Cviews as it has been instructed in the Work Instruction “Create RA Catalog Views” 
o Make sure the Cviews are created with direct relations to your Product Catalog 
o Check to see if the Cviews are not down (on a locked session)  
o Check to see if the Cview is selected by default when you process it  

 
o Check to see if products are selected under the material hierarchy (ENT/ Bonus)  
o Check to see if RA organizations are selected under the Cviews, if not then  
o Make sure your RAs are associated to the appropriate Program(s) under the Organization Maintenance screen 
o Make sure the view is up to date and running (you could make sure by clicking the update button before and 

after you process a Cview) 

 
o Make sure dates are selected for the product on the delivery date table (it is highly recommended that you 

refresh the delivery date table frequently by de-selecting and re-selecting delivery dates and saving them 
afterwards) 

o  Make sure the Lead Times are within reasonable time frame 
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35. Why can’t I see and activate the new materials added by FNS to the master catalog in my catalog view? 
Always click the "Save View and Organization" button even before making any changes to the Catalog View. This is 
recommended so that any new materials added by FNS to the master catalog will become available in the Catalog View 
for activation. 
 

36. Is there a faster way to find materials in Manage RA Catalog Views? 
Yes.  Use the Find Product search box to type in a Material # if you know the material you want to add/remove. This 
saves time from having to drill down from the left side catalog hierarchy to locate a specific material. Be sure to select the 
material from your search result that matches the Catalog view / Program you wish to work with. 
 

37. When placing a requisition, when you get to the confirmation screen asking if you want to send the order, if you 
hit cancel, what happens? Does it take you back to the order screen or does it cancel everything you’ve done and 
empty your cart?  
You’re in the Cart and hit Order, then the popup comes up and you hit Cancel: it goes right back to the cart and picks up 
where you left off – so you can make changes and place the order or cancel.  
 
 

38. When a SDA/RA saves a requisition as a Draft, does it reflect in the entitlement report?  
Draft requisitions will decrement entitlement. If you know you will not be using a particular draft requisition, then you 
should cancel the requisition. Only in “Cancelled” status will it not impact entitlement reporting.  
 

39. How can I stop receiving the Sales Order/Requisition change emails? 
To opt out of receiving Sales Order or Requisition Change emails, check the “Opt out from order change notification 
checkbox in the Manage User Profile view. 
 

 
 

40. What is the best way to distribute quantities to more than 10 RAs? 
It is recommended that you run the “Process Orders in Background” job.  

o The SDA may also submit additional redistribution background tasks for processing (for other sales orders) 
although the first task must complete before subsequent ones execute. 

o An email notification will be sent to the SDA user that submitted the job notifying that the redistribution job has 
completed.  

 
 

41. Can I search for a single material in the Domestic Order Entry Screen? 
Yes.  By entering the material # in the Quick Search box and then picking the material/program to place the order against.   
 *Method only applies to Domestic Direct Ship Ordering 

  
 

 
42. Is the entitlement reporting in real time?  

Yes.  However, if the SDA is updating the amount an RA has for ordering (planning function), the entitlement available for 
the RA will be updated during the overnight batch program.  
 

 
43. If the SDA/RA places a requisition or order, can they run their report immediately after and see the updated 

available entitlement amount?  
Yes  
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44. Is there anywhere in the ordering process that shows what entitlement is remaining to be spent without having to 

run the entitlement report?  
You can select the entitlement link at the top of the order processing screen, it does require input to run the 
entitlement/bonus report, but it allows you to see information during the ordering process rather than having to go to the 
reports tab.  
 

 
45. How are commodity values updated in WBSCM?  

Open Sales orders are updated weekly based on the average purchase price for the appropriate material purchased the 
prior week.  Once a Sales Order has been purchased it receives a final price based on the average and is not updated 
again unless there is a modification to the Sales Order/Purchase Order.  In that situation, the last average price is re-
calculated based on the new average price. 

 
 

46. Can we see what is “draft” and what was submitted as an actual order?    
Yes. Both the entitlement/bonus report and the req/order status report will reflect the appropriate status of a req/order. 
 
 

47. Will the reports show what is in “draft” status?    
Yes, “Draft” will show on the req/order status reports. 
 
 

48. On the Entitlement/Bonus Detail Report, I would like to see all the rows of information that are available. How can 
I do that? 
Displaying 1000 rows at a time is the Standard functionality in this type of report. The output will contain all the records but 
it displays only 1000. In order to see the next 1000 records, you select the 'Next' button at the bottom the screen.  
If you want to see all the records for a particular report at a time, go to that report, then Settings on the right hand side, 
select the Display tab. Enter "-1" (i.e. negative one) for number of display rows. Then it displays all the rows. Depending 
on the size of the report, you may experience slower response time when pulling all the available rows rather than using 
the default number and the “Next” button. 
  
 

49. I am a SDA and I want to run the Entitlement/Bonus summary report for all my RAs. How do I do this?  
Remove the SDA/RA default in the selection criteria area. 
 

  
50. As an SDA, if I change the entitlement notification or stop percentage, how long after it is changed will my RAs 

see it?  
The change is immediate.  
 

 
51.  I am consolidating requisitions in the consolidation workbench. I have some requisitions that I would like to 

decline. I have selected them and they have moved to the bottom of the screen under Declined.  How do I finish 
declining them?   
Once you have declined the requisition and it has moved to declined tab located near the bottom of the screen, you need 
to select the Update Requisitions button, then answer “Yes” when you see the pop-up question that you are no longer 
able to update requisitions. Once you navigate out of the workbench, if you re-enter the same material, you will no longer 
see the requisitions that are being declined. 
 
 

52. Can I create a new requisition from the consolidated workbench screen as I could in ECOS?   In WBSCM you 
cannot create a new requisition in the workbench area.  If you want to add a new requisition for a particular material, you 
can either change an existing requisition in the workbench to the delivery date/delivery location/quantity you desire or as 
an SDA you can create a new requisition on behalf of one of your RAs. 
 
 

53. Where can I see net weight on a multi-food report? 
Execute the pdf. For the Value of Materials Received – Multi-food Report to view the net weight column. 
 
 

54. Why are requisitions that have been returned by the SDA still counting against entitlement? 
The Requisition will still draw down on Entitlement until the order has been cancelled. 
 

55. I can’t see the new RAs in the entitlement budget screen.  
New RA orgs that are created in WBSCM will not automatically appear in the entitlement budgeting views.  They must be 
added either using the “New Record” button or the “Upload” button. 
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56. With the Redistribution/Redonation Report, how can I see all documents based on only a delivery date search? 

Enter 5* in the sales doc field or 1* in the Requisition field. Otherwise, results will only display Re-distribution / Redonation 
docs. 
 

57. How do I cancel a previously created redistribution? 
  

1. Click (the Blue box) beside the redistribution order you want to cancel.  
2. Click (the Cancel Redist. button) to cancel your redistribution order 
3. Click (the Yes button) to confirm that you want to cancel the redistribution document. 
4. A confirmation message indicating that your redistribution credit order (ZRCR) and redistribution order (ZRE) 

were cancelled is displayed at the top of the screen. 
5. You have completed this transaction. 

 
 

COMPLAINTS/ RECALLS –  
 
 

58. I have not received any response from FNS regarding a complaint I entered into WBSCM recently. What do I do? 
- Check that the complaint record entered has been submitted to FNS.   
- When entering a new complaint in WBSCM, the user has the button options to Save or Submit.  
- Clicking the Save button generates a complaint # and allows the user to modify the details of the complaint up to the     
   time the Submit button is clicked.  
- Once the complaint has been submitted, it cannot be modified.  
- If you require additional changes to the complaint, please contact FNS personnel to add the details on your behalf. 
- Please note that FNS will not process the complaint until it has been submitted. 
 

59. I am trying to create a complaint but when I search for my receipted sales order it does not show up.  Where is 
my sales order? 
If the order was created more than 12 months from the current date you will need to use the Creation Date with “In Period” 
selected and enter a date range further back.   

 
 

60. How can I receive recall notifications? 
To receive recall notifications, you need the "Recall Contact - External" role. You will then need to update their recall 
contact preferences by going to the Manage User Profile view (next slide) to set the devices they wish to be contacted on. 
WBSCM does not default contact preferences so it's the responsibility of the user to set this up. 
 
Note: A recall specialist will not receive notification unless they have the "Recall Contact - External" role. 
 

 
SYSTEM/ DATA--  
 

61. Is there a current list of Old Commodity Codes vs. New Material Numbers, new SDA codes, and new entity 
codes/ship-to locations?  
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Yes. The “Crosswalks” for commodity codes, SDA codes, and Entity Codes are located on the Food Distribution website 
located at:  http://www.fns.usda.gov/fdd/WBSCM/default.htm 
 
 

62. Will WBSCM kick you out after a certain amount of inactivity? If so, what is the time limit?  
Your session will time out after 30 minutes of inactivity.  
 

 
63. I am having problems with the ordering screens rendering correctly? 

Check the versions of Internet Explorer you are using. Currently, WBSCM does not always render correctly with IE8. If 
you are using IE 8 or higher, go to Tools and enable compatibility mode.  
 

 
64. I am receiving order changes emails. Are order changes the same as requisition changes?   

Yes 
 
 

65. Where is the Commodity File in WBSCM? 
Under Admin > Master Data > List of Materials – type in Plant 1000 to remove material redundancies in Report. 
 
 

66. I receive a 'Print Version Failure' error when using the Print Version button.  What do I do? 
Export the data into Excel and print the data from Excel. 
 

 
67. How do I adjust the size of my print output? 

User can "Right Click" in the order area, choose "Print Preview" and adjust settings there until you get something you can 
use. Or, you could choose the "Print" button and on the subsequent pop-up screen, adjust the print settings until you get a 
more acceptable size. However, either solution would be an adjustment on your PC and therefore outside WBSCM so we 
cannot support those efforts. 
 

68. How do I Add a Column to a WBSCM Report? 

1. Execute the Report  
2. Scroll to the far right and click the Settings link. 
3. Click Columns Selections tab 
4. Select/highlight the desired field listed under the ‘Hidden Columns’ box and click the Add button. 
5. Click the Save As button 
6. Type desired new report name in the ‘Description’ field and click the OK button. 
7. Click the Apply button. 

 

69. After selecting the WBSCM function “Export to Microsoft Excel” I received a warning message advising that the 
file was not in Excel format.  What do I do? 

8. Open the downloaded file using Microsoft Excel  
9. Select File -> Save As  
10. Select the desired Excel format to save the file (e.g. xlsx, xls, csv, xml, html, txt, pdf) 
 
 

 
70. How do I Create and Use Report Variants? 

From the Multi-Food Req Report 

To create variants: 
 
1. Define your Search Criteria 
2. Click: Variants (at the bottom of the screen). A new area "Variant Maintenance" will appear. 
3. Beside Variant: enter a name for your report (i.e. RA_1 MultiReq) 
4. Save 
  
To use variants: 
 
1. Click: Variants (at the bottom of the screen). A new area "Variant Maintenance" will appear. Beside Variant: make sure 

it's blank 
2. Enter your report name 
  

http://www.fns.usda.gov/fdd/WBSCM/default.htm


12 
Revised 4/25/2014 

 

OR 
 
1. Click the box to the right of the entry field. Pop-up "Variant Save" displayed  
2. Beside Variant: make sure it's blank  
3. Click "Start Search"  
4. Choose the variant you'd like to use. 
5. Click OK 
6. Click Load  
7. Click Execute  
 
 

WBSCM Help Desk Web Self Service--  

71. Do all WBSCM users registered into Service Now have access to the ESS module? 
Yes, all users will have access to the "Self-Service" application. 
 
 

72. What do I use to logon to the Self Service web site? 
You must use the same email address that is used on your eAuth and WBSCM accounts. 
 
 

73. How do I get my initial password for the self service site? 
You can go to the self service page and do the following to get an initial password: 
 
1. From the Service-Now login, click the "Reset your password here" link.  The form prompts you for your user ID and     

email, which for WBSCM users is the same.   
2. If there is a matching user record found, the system will send a password reset email containing a temporary  
3. Then you use the temporary password from the email to log in and you will be prompted to create a new permanent 

password.  
 

 
74. What happens if I forget my password? 

If you forget your password, go to the Service-Now logon page and click the "Reset your password here" link. Then follow 
the same steps as listed above to get a new temporary password. 
 
 

75. What can I do from the Self Service web site? 
From the self service web site you can Create a new Incident, Review your list of Open Incidents, and Look at the detailed 
information on any of your Open Incidents. 
 
 


